
1
dc1223abfa

DEMO MANUAL DC1223A-B

DESCRIPTION

USB to SMBus/SPI Interface

Demonstration circuit 1223A-B facilitates communication 
between PC-based user interface software and Linear 
Technology SMBus/I2C demonstration boards. DC1223A-B 
connects to the computer via USB. It receives power from 
the USB and isolates the computer ground from the SMBus/
I2C demonstration board. DC1223A-B adds to DC1223A, 
the SMBus monitoring feature. The DC1223A-B can be 
used in three ways, depending on the software available 
for the demonstration board under evaluation (DBUE):

QuikEval Mode

QuikEval® mode is the easiest way to communicate with 
a Linear Technology SMBus/I2C demonstration board. 
However this is limited to newer battery charger demo 
boards like the DC1259A. QuikEval application-specific 
user interfaces are available at http://www.linear.com/
designtools/software/. Figure 2 shows an example of an 
application-specific user interface for the DC1259A demo 
board.

General User Interface Mode

General user interface mode is for demo boards that do 
not offer customized software. The general user interface 
is PC-based, and graphical, but not application specific. It 
can send out discrete commands to any SMBus/I2C device 
(see Figure 2 and Appendix A), supporting nine different 
SMBus command protocols: Send Byte, Receive Byte, 

L, LT, LTC, LTM, Linear Technology and the Linear logo are registered trademarks and 
QuikEval is a trademark of Linear Technology Corporation. All other trademarks are the property 
of their respective owners.

Write Byte, Read Byte, Write Word, Read Word, Block 
Write, Block Read and Block Write-Read Process calls. It 
also supports additional command protocols for PMBus: 
Extended Read Byte, Extended Write Byte, Extended Read 
Word, Extended Write Word and Group Send. It can also 
monitor the SMBus traffic of an existing communication 
between a master and a slave. Contact the Linear Technol-
ogy sales department for the latest general user interface 
software.

DC410 Emulation Mode (Windows XP Only) 

A number of Linear Technology demonstration boards 
offer software for use with the DC410 Serial Port-to-
SMBus Interface Board, e.g. DC285 (LTC1695), DC182 
(LT1786F), DC286 (LTC1960), DC486 (LTC1760), DC496 
(LTC4008), and DC512 (LTC4100). For these boards, the 
DC1223A-B can be used to replace DC410. These demo 
boards have application-specific user interface programs 
but they are not part of the QuikEval software program. 
These application-specific programs are available from 
Linear Technology sales department.

 Note: This is not a standard mode of operation. Please 
see detailed Instructions in Appendix B to replace DC410 
with DC1223A-B .

Design files for this circuit board are available at  
http://www.linear.com/demo/DC1223A-B

http://www.linear.com/designtools/software/
http://www.linear.com/designtools/software/
http://www.linear.com/demo/DC1223A-B


2
dc1223abfa

DEMO MANUAL DC1223A-B

QUICK START PROCEDURE (QuikEval MODE)

Figure 1. Typical Equipment Setup

Demonstration circuit 1223A-B is easy to set up to 
evaluate the performance of Linear Technology SMBus/
I2C demonstration boards DC1223A-B. Refer to Figure 1 
for proper measurement equipment setup and follow the 
procedure below.

 Note: The DC1223A-B Is powered from the Host PC 
via USB.

1. Download the QuikEval software from http://www.lin-
ear.com/designtools/software/. Follow the installation 
instructions carefully.

2. When prompted to plug in the demo board, first connect 
the USB cable to the DC1223A-B and then connect the 
Demonstration Board Under Evaluation (DBUE) to the 
DC1223A-B. Power up the DBUE as recommended in 
its Quick Start Guide.

3. Check to see if there are already pull-up resistors on the 
DBUE. If yes, set jumpers JP1 and JP2 on DC1223A-B 
to Open.

4. Check to make sure jumper JP4 is on “Direct”. JP4 
should only be on “VCP” if it is doing RS232 emulation 
for replacing DC410. See Appendix B for this feature.

5. The “Found New Hardware Wizard” window may pop up. 
If it does then choose the “Recommended” Installation. 

 NOTE: If Windows cannot find the device driver, then 
select “Install from a list or specific location(Advanced)”. 
Enter the installation path as “C:\\Program Files\LTC\
QuikEval\driver”. 

 The associated software for the DBUE should pop up.

 

POWER AS
REQUIRED

DC1223

DEMO BOARD UNDER
EVALUATION

SMBUS
COMMS

USB CABLE
TO HOST PC

+VIN GND

 

DC1223AB F01

http://www.linear.com/designtools/software/
http://www.linear.com/designtools/software/
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Figure 2. DC1259A Application-Specific User Interface Program (QuikEval)

QUICK START PROCEDURE (QuikEval MODE)
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1. Make sure you have the latest version of DC1223AB.zip. 
Do not connect the USB cable to the PC yet. Install the 
DC1223A-B.msi software if not already done. http://www.
linear.com/designtools/software/. 

 Note: For Windows Vista users, please follow the in-
structions available in the DC1223A-B.zip folder. Read 
the “Installing DC1223AB_Vista.htm” file.

2. Move JP4 of DC1223A-B to Direct if it is not already 
done. This is very important!

3. Download the QuikEval software from http://www.lin-
ear.com/designtools/software/. Follow the installation 
instructions carefully.

4. When prompted to plug in the demo board, first connect 
the USB cable to the DC1223A-B and then connect the 
Demonstration Board Under Evaluation (DBUE) to the 
DC1223A-B. Power up the DBUE as recommended in 
its Quick Start Guide.

5. Connect the hardware the same way as shown in 
Figure 6.

 Note: It is not necessary to use a DC486. Any SMBus 
device with SCL, SDA, GND can be connected to 
DC1223A-B via the P2 connector. For example you can 
use a smart battery as a SMBus device as shown in 
Figure 6. Smart battery is a master/slave device.

6. Launch DC1223A-B_Monitor.exe.

7. A General User Interface window appears as shown in 
Figure 4. Input the slave address and the commands 
to talk to the smart battery or LTC1760. 16HEX is the 
slave address of the smart battery. A 16HEX device 
command is the AlarmWarning() command sent to 
the battery. The read word result is 00C0HEX, meaning 
no alarms raised except that the battery is currently 
discharging. For more information about the meaning 
of device command 16HEX go to View → SBS → SBS 
Table.

8. To go into SMBus Monitor mode, go to Tools → Monitor. 
You will see the windows in Figure 5. For more detail 
instructions go to Help → Help Topics.

Figure 4. General User Interface for SMBus Communication

Figure 3. SCL, SDA, GND Connections to Any SMBus Device

APPENDIX A: USING DC1223A-B’s GENERAL USER INTERFACE

http://www.linear.com/designtools/software/
http://www.linear.com/designtools/software/
http://www.linear.com/designtools/software/
http://www.linear.com/designtools/software/


5
dc1223abfa

DEMO MANUAL DC1223A-B

APPENDIX A: USING DC1223A-B’s GENERAL USER INTERFACE

Figure 5. General User Interface SMBus Monitor Mode
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A number of older battery charger demonstration boards, 
including the DC286 (LTC1960), DC486 (LTC1760), DC496 
(LTC4008) and DC512 (LTC4100) used the DC410 to send 
SMBus commands to/from a PC via a serial RS232 com 
port. The software developed for this configuration was 
based on Labview. This software is provided when you 
order these older demo boards.

Please contact Linear Technology Applications if you need 
a copy. However, as RS232 is disappearing, and is being 
replaced by USB, the DC1223A-B replaces the DC410. The 
DC1223A-B can be used to emulate a RS232 com port 
for backwards compatibility with the existing application-
specific Labview software.

 Note: If you don’t want to use the legacy Labview 
software which requires RS232 emulation, you can 
alternatively use a General User Interface(GUI) software 
developed to communicate using DC1223A-B which 
does not require RS232 emulation (use USB directly). 
However you will be missing the user friendly interface 
specific to a particular device, for example the LTC1760, 
LTC4100 or LTC1960 available in the legacy Labview 
program. Instead the GUI requires you to input the 
parameters yourself. For the GUI program, skip the 
below instructions and go to the Appendix A.

So the new configuration is a DC486 (for example) and a 
DC1223A-B. The same Labview software can still be used. 
However, you need to follow these steps as it involved 
RS232 emulation.

Installing Software to Emulate DC410 (RS232)

1. Connect the hardware as shown in Figure 6. Do not 
connect the USB port to the computer yet.

2. DC1223A-B jumper positions should be:

  JP5 on “5V”

  JP4 on “VCP” (Virtual Com Port)

 Note: This is a very important step. When you change 
the jumper to JP4, you are telling the FTDI chip to 
emulate a RS232 port. If JP4 is on “Direct”, the FTDI 
chip will communicate directly as a USB.

3. Install DC1223A-B.msi, but don’t run it. If you need 
a copy of the software please go to http://www.linear.
com/designtools/software/. 

 Note: For Windows Vista users, please follow the in-
structions available in the DC1223A-B.zip folder. Read 
the “Installing DC1223AB_Vista.htm” file.

4. Download the QuikEval software from http://www.lin-
ear.com/designtools/software/. Follow the installation 
instructions carefully.

5. When prompted to plug in the demo board, first connect 
the USB cable to the DC1223A-B and then connect the 
Demonstration Board Under Evaluation (DBUE) to the 
DC1223A-B. Power up the DBUE as recommended in 
its Quick Start Guide.

6. Go to the computer’s device manager by choosing 
(Start → Control Panel → System → Hardware tab 
Device Manager). Look at the ports (COM and LPT).

 Notice the USB Serial Port (COM4). This tells you that 
a Virtual Com Port now exists (the USB emulated a 
RS232 com port) so that you can continue using the 
legacy Labview program. See Figure 8.

7. If the RS232 com port emulated is higher than 4, please 
change it to any number between 1 and 4 by right click-
ing on ports (COM & LPT), select the Port Settings tab 
and select Advanced. Change the Com port number to 
a number from 1 to 4. See Figure 9. 

8. Launch the software for the demo board under evalu-
ation (e.g., DC486) and when prompted to enter the 
RS232 com port, use the number you obtained from 
step 8. If you need a copy of the software please contact 
Linear Technology Sales Department. For DC486, you 
will need dc486v2.exe. See Figure 10.

APPENDIX B: DC410 EMULATION MODE (WINDOWS XP ONLY)

http://www.linear.com/designtools/software/
http://www.linear.com/designtools/software/
http://www.linear.com/designtools/software/
http://www.linear.com/designtools/software/
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Figure 6. Hardware Setup Between a DC1223A-B and a DC486 (Can Be DC512, DC486, DC286, Etc.). JP4 Should Be on VCP.

Figure 7. Driver Installation

APPENDIX B: DC410 EMULATION MODE (WINDOWS XP ONLY)
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Figure 8. Device Manager

Figure 9. Change the COM Port that USB is Emulating

APPENDIX B: DC410 EMULATION MODE (WINDOWS XP ONLY)
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Figure 10. Launch DC486 Software and Select the COM Port Emulated in Step 8

APPENDIX B: DC410 EMULATION MODE (WINDOWS XP ONLY)
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ITEM QTY REFERENCE PART DESCRIPTION MANUFACTURER/PART NUMBER

1 15 C1-C3, C5-C11, C13-C16, C18 CAP., X7R 0.1μF 16V 10% AVX 0603YC104KAT2A

2 1 C4 CAP., X5R 1μF 16V 10% TAIYO YUDEN EMK107BJ105KA-T

3 1 C12 CAP., X7R 0.01μF 25V 10% AVX 06033C103KAT2A

4 1 C17 CAP., X5R 100μF 6.3V 20% TAIYO YUDEN JMK325BJ107MM-T

5 1 C19 CAP., NPO 330pF 25V 5% AVX 06033A331JAT2A

6 1 C20 CAP., X7R 2200pF 1kV 20% AVX 1206AC222MAT2A

7 2 C21, C23 CAP., X5R 22μF 25V 20% AVX 12103D226MAT2A

8 2 C22, C24 CAP., X5R 10μF 10V 10% TAIYO YUDEN LMK212BJ106KG-T

9 2 D1, D3 LED, GRN PANASONIC LN1351CTR

10 3 D2, D4, D5 SCHOTTKY (COMM-ANODE) DIODE DIODE INC. BAT54A-7-F

11 2 D6, D7 SCHOTTKY DIODE, DUAL SOT23 DIODES INC. BAT54S-7-F

12 2 E1, E2 TURRET, TESTPOINT MILL MAX 2308-2-00-80-00-00-07-0

13 1 FB1 FERRITE BEAD, PBF STEWARD MI0805K400R-10

14 3 JP1-JP3 HEADERS, DBL. ROW 2 × 3 2mm CTRS. SAMTEC, TMM-103-02-L-D

15 1 JP4 HEADERS SQ. POST, DBL. ROW 2 × 3, 0.1mm CTRS. SAMTEC, TSW-103-07-L-D

16 1 JP5  HEADERS, 1 × 3, 2mm CTRS. SAMTEC TMM-103-02-L-S

17 1 J1 USB CONN, TYPE B RECEPTACLE MILL-MAX 897-43-004-90-000000

18 1 P1 CONN, DB15-M 2mm AMP INC. 574-9767-1

19 1 P2 HEADERS, DBL. ROW 0.1mm CTRS. SAMTEC TSW-112-07-L-D

20 1 Q1 XSTR. NPN 40V 350mW SMD SOT23 DIODES INC. MMBT3904-7-F

21 2 Q2,Q3 MOSFET, N-CH. 60V 115mA SOT23 DIODES INC. 2N7002-7-F

22 3 R1, R2, R8 RES., CHIP, 15k, 0.1W, 5%, 0603 YAGEO, RC0603JR-0715KL

23 2 R3,R4 RES., CHIP, 750Ω, 0.1W, 5%, 0603 YAGEO, RC0603JR-07750RL

24 11 R5, R6, R9, R10, R12, R16, 
R19, R32-R34, R36

RES., CHIP, 10k, 0.1W, 5%, 0603 PANASONIC ERJ3GEYJ103V

25 2 R7, R37 RES., CHIP, 49.9k, 1/16W, 1%, 0603 YAGEO, RC0603FR-0749K9L

26 1 R11 RES., CHIP, 5.1k, 0.1W, 5%, 0603 PANASONIC ERJ-3GEYJ512V

27 1 R13 RES., CHIP, 5.11k, 1/16W, 1%, 0603 NIC COMP. CORP., NRC06F5111TRF

28 1 R14 RES., CHIP, 80.6Ω, 1/16W, 1%, 0603 YAGEO, RC0603FR-0780R6L

29 3 R15, R26, R29 RES/JUMPER, CHIP, 0, 1 AMP, 0603 YAGEO, RC0603FR-070RL

30 0 R17 (OPT) RES/JUMPER, CHIP, 0, 1 AMP, 1206 YAGEO, RC1206FR-070RL

31 2 R18, R25 RES., CHIP, 1.5k, 0.1W, 5%, 0603 YAGEO, RC0603JR-071K5L

32 1 R20 RES., CHIP, 100k, 0.1W, 5%, 0603 VISHAY, CRCW0603100KJNEA

33 2 R21, R28 RES., CHIP, 1MΩ, 0.1W, 5%, 0603 YAGEO, RC0603JR-071ML

34 1 R22 RES., CHIP, 470Ω, 0.1W, 5%, 0603 YAGEO, RC0603JR-07470RL

35 2 R23, R24 RES., CHIP, 27Ω, 0.1W, 5%, 0603 YAGEO, RC0603JR-0727RL

36 0 R27, R31 (OPT) RES/JUMPER, CHIP, 0, 1A YAGEO, RC0603FR-070RL

37 1 R30 RES., CHIP, 2.2k, 0.1W, 5%, 0603 YAGEO, RC0603JR-072K2L

38 1 R35 RES., CHIP, 16.9k, 0.1W, 1%, 0603 VISHAY, CRCW060316K9FKEA

39 1 R38 RES., CHIP, 26.7k, 0.1W, 1%, 0603 YAGEO, RC0603FR-0726K7L

APPENDIX C: SCHEMATICS AND BILL OF MATERIALS
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ITEM QTY REFERENCE PART DESCRIPTION MANUFACTURER/PART NUMBER

40 1 R39 RES., CHIP, 102k, 0.1W, 1%, 0603 YAGEO, RC0603FR-07102KL

41 1 R40 RES., CHIP, 41.2k, 0.1W, 1%, 0603 YAGEO, RC0603FR-0741K2L

42 1 S1  SWITCH, EVQPJS05K PANASONIC EVQPJS05K

43 1 T1 TRANSFORMER, 2.5:1:1 PULSE PA0510NLT

44 1 U1 I.C., SMBUS ACCELERATOR LINEAR TECH. CORP. LTC1694CS5

45 1 U2 I.C., ANALOG MULTIPLEXER TEXAS INST. SN74LV4052ADRE4

46 1 U3 I.C., 3-SUPPLY MONITOR LINEAR TECH. CORP. LTC1326CS8

47 1 U4 I.C., MICROCONTROLLER, (#FW410V3) PROGRAM MICROCHIP, PIC16F76-I/SO

48 1 U5 I.C., LOW PWR. RESISTOR SET OSC. LINEAR TECH. CORP. LTC1799CS5

49 1 U6 I.C., SERIAL DATA TRANSFER FUTURE TECH. DEVICES INT’L FT232BL(PBF)

50 1 U7 I.C., ISOLATOR NARROW BODY AVAGO TECH. HCPL-091J-000E (PBF)

51 1 U8 I.C., EEPROM MICROCHIP 93C46B-I/MS

52 1 U9 I.C., DC/DC XFMR DRIVER LINEAR TECH. CORP. LT3439EFE

53 1 U10 I.C., LDO REGULATOR LINEAR TECH. CORP. LT1761ES5-SD

54 1 U11 I.C., LOW DROPOUT W/SHUTDOWN LINEAR TECH. CORP. LT1121CS8-5

55 3 XJP1 - XJP2, XJP5 SHUNT, 2mm CTRS. SAMTEC 2SN-BK-G

56 1 XJP4 SHUNT, 2 × 2, 0.1mm CTRS. SAMTEC MNT-102-BK-G

57 1 Y1 CER. RESONATOR, 6MHZ MURATA CSTCR6M00G15L**-R0

58 4 MTG 4 CORNERS STAND-OFF, NYLON, 0.25 TALL KEYSTONE, 8831 (SNAP ON)

59 1 CABLE A-B MALE DBL SHIELD 2M ASSMANN ELECTRONICS AK672

60 1 MINIGRABBER TEST CLIP PATCH CORD, BLACK POMONA 3781-12-0

61 1 MINIGRABBER TEST CLIP PATCH CORD, BLUE POMONA 3781-12-6

62 1 MINIGRABBER TEST CLIP PATCH CORD, WHITE POMONA 3781-12-9

63 1 FAB, 1223A_REV2.PCB DEMO CIRCUIT 1223A-B

64 1 STENCIL: ST-1223A-REV0 STENCIL 1223A

APPENDIX C: SCHEMATICS AND BILL OF MATERIALS
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APPENDIX C: SCHEMATICS AND BILL OF MATERIALS
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APPENDIX C: SCHEMATICS AND BILL OF MATERIALS
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APPENDIX C: SCHEMATICS AND BILL OF MATERIALS
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Information furnished by Linear Technology Corporation is believed to be accurate and reliable.  
However, no responsibility is assumed for its use. Linear Technology Corporation makes no representa-
tion that the interconnection of its circuits as described herein will not infringe on existing patent rights.

A A

B B

C C

D D

E E

4
4

3
3

2
2

1
1

IS
O

L
A

T
IO

N



U
S

B
 t
o
 S

M
B

u
s
/S

P
I 
In

te
rf

a
c
e
 B

o
a
rd





















D
av

id
 C

an
n

y


















D
o

c
u

m
e

n
t 
N

u
m

b
e
r




D
a

te
:

S
h

e
e

t
o

f








D

R
A

W
N

:

E
N

G
I
N

E
E

R
:

A
P

P
R

O
V

E
D

:

C
H

E
C

K
E

D
:


































































































































S
D
















































 








 

























































 





 



 

 










 






















































































































































































 

 





 






 

 





 


APPENDIX C: SCHEMATICS AND BILL OF MATERIALS
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DEMONSTRATION BOARD IMPORTANT NOTICE

Linear Technology Corporation (LTC) provides the enclosed product(s) under the following AS IS conditions:

This demonstration board (DEMO BOARD) kit being sold or provided by Linear Technology is intended for use for ENGINEERING DEVELOPMENT 
OR EVALUATION PURPOSES ONLY and is not provided by LTC for commercial use. As such, the DEMO BOARD herein may not be complete 
in terms of required design-, marketing-, and/or manufacturing-related protective considerations, including but not limited to product safety 
measures typically found in finished commercial goods. As a prototype, this product does not fall within the scope of the European Union 
directive on electromagnetic compatibility and therefore may or may not meet the technical requirements of the directive, or other regulations.

If this evaluation kit does not meet the specifications recited in the DEMO BOARD manual the kit may be returned within 30 days from the date 
of delivery for a full refund. THE FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY THE SELLER TO BUYER AND IS IN LIEU 
OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR ANY PARTICULAR PURPOSE. EXCEPT TO THE EXTENT OF THIS INDEMNITY, NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR 
ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user releases LTC from all claims 
arising from the handling or use of the goods. Due to the open construction of the product, it is the user’s responsibility to take any and all 
appropriate precautions with regard to electrostatic discharge. Also be aware that the products herein may not be regulatory compliant or 
agency certified (FCC, UL, CE, etc.).

No License is granted under any patent right or other intellectual property whatsoever. LTC assumes no liability for applications assistance, 
customer product design, software performance, or infringement of patents or any other intellectual property rights of any kind.

LTC currently services a variety of customers for products around the world, and therefore this transaction is not exclusive.

Please read the DEMO BOARD manual prior to handling the product. Persons handling this product must have electronics training and 
observe good laboratory practice standards. Common sense is encouraged.

This notice contains important safety information about temperatures and voltages. For further safety concerns, please contact a LTC application 
engineer.

Mailing Address:

Linear Technology

1630 McCarthy Blvd.

Milpitas, CA 95035

Copyright © 2004, Linear Technology Corporation



 

 
 

Компания «ЭлектроПласт» предлагает заключение долгосрочных отношений при 
поставках импортных электронных компонентов на взаимовыгодных условиях! 

 
Наши преимущества: 

 Оперативные поставки широкого спектра электронных компонентов отечественного и 
импортного производства напрямую от производителей и с крупнейших мировых 
складов; 

  Поставка более 17-ти миллионов наименований электронных компонентов; 

 Поставка сложных, дефицитных, либо снятых с производства позиций; 

 Оперативные сроки поставки под заказ (от 5 рабочих дней); 

 Экспресс доставка в любую точку России; 

 Техническая поддержка проекта, помощь в подборе аналогов, поставка прототипов; 

 Система менеджмента качества сертифицирована по Международному стандарту ISO 
9001; 

 Лицензия ФСБ на осуществление работ с использованием сведений, составляющих 
государственную тайну; 

 Поставка специализированных компонентов (Xilinx, Altera, Analog Devices, Intersil, 
Interpoint, Microsemi, Aeroflex, Peregrine, Syfer, Eurofarad, Texas Instrument, Miteq, 
Cobham, E2V, MA-COM, Hittite, Mini-Circuits,General Dynamics и др.); 
 

Помимо этого, одним из направлений компании «ЭлектроПласт» является направление 
«Источники питания». Мы предлагаем Вам помощь Конструкторского отдела: 

 Подбор оптимального решения, техническое обоснование при выборе компонента; 

 Подбор аналогов; 

 Консультации по применению компонента; 

 Поставка образцов и прототипов; 

 Техническая поддержка проекта; 

 Защита от снятия компонента с производства. 
 
 
 

 
 

Как с нами связаться 

Телефон: 8 (812) 309 58 32 (многоканальный)  
Факс: 8 (812) 320-02-42  
Электронная почта: org@eplast1.ru  

Адрес: 198099, г. Санкт-Петербург, ул. Калинина, 

дом 2, корпус 4, литера А.  
 

mailto:org@eplast1.ru

